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Introduction

           
Introduction
Thank you for purchasing the Canon S200 Bubble Jet Printer.  This User’s Guide provides 
complete explanations of the features and functions of the printer. 

This guide uses the following symbols to indicate important information.  Always observe 
these instructions.

Warning ➤ Instructions that, if ignored, could result in death or serious personal injury 
caused by incorrect operation of the equipment.
Must be observed for safe operation.

Caution ➤ Instructions that, if ignored, could result in personal injury or material 
damage caused by incorrect operation of the equipment. 
Must be observed for safe operation.

Important ➤ Prohibited actions that, inadvertently performed, could result in equipment 
damage, faults or impaired product quality.
Must be avoided for correct operation.

Information for Windows users only.

Information for Macintosh users only.

Windows

Macintosh
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How to Use This Manual
To view this User’s Guide, we recommend that you use Acrobat Reader 4.0 or Acrobat 
Reader 3.0.  Please note that screens displayed by Acrobat Reader 3.0 are slightly 
different.

Use this button to enlarge the 
viewing screen.  Select this button 
in the tool bar and click within the 
screen.  

 Displays the next page.

Returns to the 
page you were 
previously 
viewing.

 
 Displays the previous page.

Click to jump straight to 
this page.
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How to Use This Manual
Displays the table of contents.  
Click the heading to jump to the topic.
Click the “ ” symbol to see the headings for each chapter.
Click the “ ” symbol to close the headings.

Use this button 
to search for a 
word.
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Safety Precautions
Please read the safety warnings and cautions provided in this manual to ensure that you 
use the printer safely.  Do not attempt to use the printer in any way not described in this 
manual.

Warning ➤ You may cause an electric shock/fire or damage the printer if you ignore 
any of these safety precautions.

■ Choosing a location

Do not place the printer close to flammable solvents, such as alcohol or thinners.

■ Power supply

Never attempt to plug in or unplug the power cord from the power supply when your 
hands are wet.

Regularly unplug the printer, and clean the plug itself and the area around the plug to 
remove accumulated dust and/or stains with a dry cloth.

Always push the plug all the way into the power outlet.

Never damage, modify, stretch or excessively bend or twist the 
power cord.  Do not place heavy objects on the power cord.
8



  

Safety Precautions

       
Never plug the printer into a power supply that is shared with other 
equipment (extension lead, double adapter, etc.).

Never use the printer if the power cord is bundled or knotted.

If you detect smoke, unusual smells or strange noises around the printer, immediately 
unplug the printer at the power supply and contact the Customer Care Center.

■ Cleaning the printer

Use a damp cloth to clean the printer.  Never use flammable solvents 
such as alcohol, benzene or thinners.

If flammable solvents come in contact with electrical components inside the 
printer, it could cause a fire or electric shock.

Always unplug the printer from the power outlet before cleaning the printer.

If you do not unplug the printer before cleaning it, you could injure yourself or damage the printer.
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Safety Precautions

           
■ Maintaining the printer

Do not attempt to disassemble or modify the printer.  There are no user serviceable parts 
inside the printer.

The printer contains high-voltage components. Never attempt any maintenance procedure not described in 
this guide.

■ Working around the printer

Do not use inflammable sprays near the printer.

This could cause a fire or electric shock if the spray comes into contact with electrical components inside 
the printer.

Caution ➤ You may cause injury or damage the printer if you ignore any of these 
safety precautions.
10



  

Safety Precautions

      
■ Choosing a location

Do not set up the printer in a location that is unstable or subject to excessive vibration.

Do not set up the printer in locations that are very humid or dusty, in direct sunlight, 
outdoors, or close to a heating source.

To avoid the risk of fire or electric shocks, install the printer in a location with an ambient temperature range 
of 41°F to 95°F (5°C to 35°C) and humidity of 10% to 90% (condensation free).

Do not place the printer on a thick rug or carpet.

Ensure that the area around the power supply is kept clear at all 
times so you can easily unplug the power cord if necessary.

When you to transport the printer, be sure to hold both edges of the printer with your 
fingers of both hands securely, or hold the handle of the printer.

If you happen to hold the printer carelessly, you may drop it and then you may be injured.
11



  

Safety Precautions

      
■ Power supply

Never remove the plug by pulling on the power cord.

Do not use an extension lead.

If you do not intend to use the printer for a long period of time, unplug the printer.

Never use a power supply voltage other than that supplied in the country of purchase.

The correct power supply voltage and frequency is as follows:
USA/Canada: AC 120-127V, 60Hz
Europe: AC 230V ± 10%, 50Hz
Australia: AC 240V, 50Hz
12



  

Safety Precautions

            
■ Working around the printer

Never put your hands or fingers in the printer while it is printing.

Do not place metal objects (paper clips, staples, etc.) or containers of flammable 
solvents (alcohol, thinners, etc.) on top of the printer.

If any foreign object (metal or liquid) falls into the printer, unplug the power cord and 
contact the Customer Care Center.

■ Regularly unplug the printer, and clean the plug itself and around the plug to 
remove accumulated dust.

If you leave the printer connected to the power plug for a long time in a place subject to 
much dust, hummidity or greasy fumes, dust accumulated around the power supply 
takes up moisture to cause insufficient insulation, then a fire.

■ Printheads and ink tanks

For safety reasons store printheads and ink tanks out of the reach of small children.

If a child ingests any ink, consult a doctor immediately.

Do not shake printheads or ink tanks.

Ink may leak out and stain clothing or the surrounding area.
13



  

Safety Precautions

  
Never touch the electrical contacts on a printhead after printing.

The metal parts may be very hot and could cause burns.
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Printer Parts and Their Functions

• Front View

• Rear View

• Inside the Printer
15



  

Printer Parts and Their Functions

 

Front View

RESUME/CANCEL Button
Press to resume printing once an 
error has been resolved. After the 
printer initializes, it is ready for 
printing. Also, to cancel printing in 
progress, press this button.
This printer does not have a Power switch.
Warming up starts as soon as it is plugged 
in. Unless unplugged, the printer will remain 
ready to print with a very low level of power 
consumption.

Paper Rest

Sheet Feeder
Load paper here.  
Paper feeds 
automatically, one sheet 
at a time.

Front Cover
Open to replace the ink tanks or 
remove jammed paper.

Do not open the front cover unnecessarily. 
Printhead cleaning will start automatically 
upon opening and closing the front cover 
and this process consumes ink.Paper Output Tray

Paper Guide
When loading paper, 
ensure the left edge 
just touches this guide. 
To move the paper 
guide, pinch the knob 
and slide it in the 
appropriate direction.
Front View 16



  

Printer Parts and Their Functions

 

Rear View

USB Port
Connects the printer to a computer 
through a USB interface.

Power cord connector
Connect the supplied cord into this 
connector.

Handle
Hold this handle with your fingers of both 
hands to move the printer a short distance.
Be sure to hold this handle with your fingers of both 
hands securely. If you happen to hold it carelessly, 
you may drop it and then you may be injured.
Rear View 17



  

Printer Parts and Their Functions

 

Inside the Printer

Paper Thickness Lever
Adjusts the gap between the printhead and the surface 
of the printing paper.

Cartridge Lock Lever
Locks the BJ Cartridge into the holder.  
Once the BJ Cartridge is installed, do not touch 
this lever.

Cartridge Holder
Install the BJ Cartridge here.
The BJ Cartridge consists of a 
printhead and two ink tanks.
Inside the Printer 18



  

Printer Parts and Their Functions

  
Configuration of the BJ Cartridge

The BJ Cartridge consists of a printhead and two ink tanks (expendable supplies), as shown 
below. When the printer runs out of ink, replace only the empty ink tank with a new one.

BCI-24 Color
Printhead

BJ Cartridge

BCI-24 Black
Configuration of the BJ Cartridge 19
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Printer Driver Functions (Windows)

• Opening the Printer Properties Dialog Box

• Printer Properties Dialog Box Description

• BJ Status Monitor Functions

• Cancelling a Print Job

• Uninstalling Printer Drivers
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Printer Driver Functions (Windows)

       
Opening the Printer Properties Dialog Box

The Printer Properties dialog box can be opened from either within an application, or 
directly from the Windows Start menu.

■ Opening the Printer Properties dialog box from an application

This method is generally used to specify printer settings just before printing.
The operations may vary slightly depending on the application. This section describes 
only the general procedure for opening the Printer Properties dialog box. 

1 In the application, select the command to print a document.

The Print dialog box can usually be opened by selecting Print from the File 
menu. Ensure that Canon S200 is selected in the Name field. 

To open the Printer Properties dialog box, select:
• Windows Me/Windows 98 ➔ Properties
• Windows XP/Windows 2000 ➔ Printing Preferences...

The Printer Properties dialog box opens. 

Note ➤ Depending on the application, the command and menu names may differ, 
and more steps may be involved in opening the Printer Properties dialog 
box. For further details, see the user’s manual for the application. 
Opening the Printer Properties Dialog Box 21



Printer Driver Functions (Windows)
■ Opening the Printer Properties dialog box directly from the Start menu

This method is used for maintenance operations, such as printhead cleaning, or to 
specify printer settings common to all application programs.
When the Printer Properties dialog box is opened from the Start menu, additional tabs 
appear, including the Details tab. These do not appear when the Printer Properties 
dialog box is opened from within an application. 
For further information about these additional tabs, refer to your Windows 
documentation.

1 Click the Start button, and select:
• Windows Me/Windows 2000/Windows 98 ➔ Printers in Settings
• Windows XP ➔ Control Panel - Printer and Other Hardware - Printers 

and Faxes

2 Select the Canon S200 icon.

3 Open the File menu and select:
• Windows Me/Windows 98 ➔ Properties
• Windows XP/Windows 2000 ➔ Printing Preferences...

The Printer Properties dialog box opens. 
Opening the Printer Properties Dialog Box 22



Printer Driver Functions (Windows)
Printer Properties Dialog Box Description

Note ➤ The screens in this section refer to Windows Me/Windows 98 operation. 
The equivalent screens for Windows XP/Windows 2000 may look slightly 
different.

• Effects Tab

• Maintenance Tab

• Main Tab
• Page Setup Tab
• Stamp/Background Tab

• Profiles Tab
Printer Properties Dialog Box Description 23



Printer Driver Functions (Windows)
Main Tab

(1) Media Type 
Ensure this setting matches the type of media loaded in the printer. 

(2) Print Quality 
Select the print quality you require from among the different options. To select a 
custom Print quality, select Custom and click the Set... button. 

(6)

(5)

(4)

(1)

(2)

(3)
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Printer Driver Functions (Windows)
(3) Color Adjustment 
Select the method of color adjustment. To make detailed color adjustments, select 
Manual, then click the Set... button. 

(4) Grayscale Printing 
Select to print a grayscale version of a color document. 

(5) Print Advisor...
Click to start the Print Advisor.
The Print Advisor simplifies configuration of the printer driver. By having the user 
answer a series of questions, the Printer Advisor automatically configures the printer 
driver settings.

(6) Preview Area
Before starting printing, verify that settings, such as the lever position, are correct.

Note ➤ To see a description of any item in the Printer Properties dialog box, click 
the ? mark then click the desired item. To see a description of operating 
procedures, click the Help button. If the button does not appear when using 
Windows XP/Windows 2000, click the Start button then select Programs - 
Canon S200 - Guide.
Printer Properties Dialog Box Description 25



Printer Driver Functions (Windows)
Page Setup Tab

(1) Page Size 
Ensure the correct paper size is selected.

(7)

(2)

(1)

(3)

(5)
(6)

(4)
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Printer Driver Functions (Windows)
(2) Orientation 
Select landscape or portrait printing and ensure it is the same orientation used in the 
application. 

(3) Printing Type 
Select the printing method from among the following.

Normal-size Printing The document is printed according to the original 
dimensions. This setting is usually selected by default. 

Fit-to-Page Printing The document is automatically resized and printed to fit into 
a specified page size.

Scaled Printing The document is resized when printed. When this is 
selected, you can specify the Printer Paper Size and 
Scaling.

Page Layout Printing Pages are reduced and printed so that multiple document 
pages fit on each printed page.

Booklet Printing The multiple-page document is printed so that two pages of 
the document fit on each printed page. The print order is set 
automatically. After the document is printed, you can create 
a booklet by folding and saddle-stitching the document.

Poster Printing This enlarges and splits the print image across several 
sheets of paper. The printed sheets can then be assembled 
to make a large poster.

Banner Printing Select this when printing on banner paper.

(4) Duplex Printing
The document is printed on both sides of the paper. After printing one side, turn the 
ejected page over, and print on the other side.
.

Printer Properties Dialog Box Description 27



Printer Driver Functions (Windows)
(5) Reverse order 
Prints the document starting with the last page. 

(6) Collate 
Select to print multiple copies of the document one copy at a time.

(7) Preview Area
Verify the overall layout, stamps, background, etc., to be applied to the print job. 

Note ➤ When you are to print a Web page, the entire page may not be printed. 
In such a case, select Scaled Printing as Printing Type.
Printer Properties Dialog Box Description 28



Printer Driver Functions (Windows)
Stamp/Background Tab

(1) Stamp 
Select the check box and choose the stamp. 

(2) Define Stamp... 
This allows you to create new stamps, or modify details of a selected stamp. 

(1)

(3)
(4)

(2)

(5)

(7)
(6)(8)
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Printer Driver Functions (Windows)
(3) Place stamp over text 
When Stamp is selected, you can select this check box. When selected, the stamp is 
printed over the print data.

(4) Stamp first page only 
When Stamp is selected, you can select this check box. When selected, the stamp is 
printed only on the first page.  

(5) Background 
Select the check box and choose the background image you wish to use. 

(6) Select Background... 
This allows you to register a new background, or to display details of the background 
you have selected. 

(7) Background first page only 
When Background is selected, you can select this check box. When selected, the 
background image is printed only on the first page. 

(8) Preview Area
Shows how your page will look when printed.
Printer Properties Dialog Box Description 30



Printer Driver Functions (Windows)
Effects Tab

(1) Simulate Illustration 
This function manipulates color image data with certain effects. Select the check box 
and adjust the brightness of the image with the Contrast slide bar.

(6)

(1)

(2)

(4)

(3)

(5)
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Printer Driver Functions (Windows)
(2) Monochrome Effects 
Prints a color image in a single color. Select the check box and choose a color or use 
a custom color using Select Color.

(3) Vivid Photo
Prints a photo or image data in vivid colors.
By enlarging the blue and green color areas, this function prints the blue sky or green 
trees of a photo vividly.

(4) Image Optimizer 
Improves the contours and smoothes jaggedness that occur when photographic or 
graphic image data is enlarged within an application.

(5) Photo Optimizer PRO 
Optimizes the color of images taken from a digital camera or scanner. It is especially 
useful for images affected by color imbalance and over- or under-exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut and paste, rotation or other such operations, group optimization 
of all images on the one page is recommended. In such cases, select the Apply 
Throughout Page check box. 

(6) Preview Area
Shows how your page will look when printed.
Printer Properties Dialog Box Description 32



Printer Driver Functions (Windows)
Profiles Tab

(1) Printing Profiles 
This list displays the printing settings currently registered in the Profiles tab.
The Current Settings profile contains the settings currently specified in the Main, 
Page Setup, Stamp/Background and Effects tabs. The Default Settings profile 
contains the factory default settings.

(1)

(4)

(2)

(3)

(6)

(5)
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Printer Driver Functions (Windows)
(2) Details 
Displays all the printer settings selected in Printing Profiles.

(3) Description 
Displays a description of the printer settings selected in Printing Profiles. You can 
enter the description when saving the printer settings. 

(4) Add to Profiles... 
Click to save the settings currently specified in the Main, Page Setup, Stamp/
Background and Effects tabs. Select Current Settings in the Printing Profiles list, 
and then click this button. The Add to Profiles... dialog box appears.

(5) Retrieve from Profiles 
Click to activate registered printer settings. The contents of the Main, Page Setup, 
Stamp/Background and Effects tabs are changed by selecting the printer settings in 
Printing Profiles and then clicking this button.
This button is disabled when Current Settings is selected.

(6) Delete 
Click to delete unwanted printer settings. Select the unwanted item in the Printing 
Profiles list and click the Delete button. 
Current Settings and Default Settings cannot be deleted.
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Printer Driver Functions (Windows)
Maintenance Tab

(1) Cleaning 
Click to start printhead cleaning.

(2) Deep Cleaning 
Click to start printhead deep cleaning.
Use this function only if Cleaning has not improved the print quality.

(1)

(2)

(5) (7)

(8)

(3)

(4)

(6)
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Printer Driver Functions (Windows)
(3) Print Head Alignment 
Aligns the printhead. For details on printhead alignment, refer to “Printhead 
Alignment”.

(4) Nozzle Check 
Prints the nozzle check pattern to ensure the printhead nozzles are outputting ink 
normally. For details, refer to “Examining the Nozzle Check Pattern”.

(5) Ink Counter Reset 
Resets the ink counter to an initial value. Click this button each time you replace an ink 
tank if you have enabled the low ink warning function.

(6) Low Ink Warning Setting 
This allows you to enable the low ink warning function. This option is off by default.

(7) Custom Settings... 
Click to modify the printer mode. Change the settings in the Custom Setting dialog 
box and click Send to change printer mode.

(8) Start Status Monitor 
Click to start the BJ Status Monitor, to check the printer status and the progress of 
printing jobs. 

Note ➤ In Windows XP/Windows 2000, you may not select any maintenance 
function if you invoke this tab from your application. In such a case, open 
the Printer Properties dialog box directly from the Start menu 
(see page 22).
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Printer Driver Functions (Windows)
BJ Status Monitor Functions

The BJ Status Monitor allows you to check the status of the printer. 
If an error occurs, the status monitor indicates the nature of the error and suggests an 
appropriate solution. When the low ink warning is enabled, the status monitor also checks 
the ink tanks and displays a warning message when the ink is low.

■ Launching the BJ Status Monitor

The BJ Status Monitor launches automatically when data is sent to the printer. When 
launched, the BJ Status Monitor appears as an icon on the Task Bar. 

1 Click the Canon BJ Status Monitor (Windows Me/Windows 98) or Canon 
S200 - USB001 (Windows XP/Windows 2000) icon on the Task Bar.

The BJ Status Monitor appears.
BJ Status Monitor Functions 37



Printer Driver Functions (Windows)
Note ➤ To open the BJ Status Monitor when the printer is not printing, click the 
Maintenance tab in the Printer Properties dialog box and click the Start 
Status Monitor button.
BJ Status Monitor Functions 38



Printer Driver Functions (Windows)
■ When errors occur

The BJ Status Monitor is automatically displayed when an error occurs (e.g., if the printer 
runs out of paper or paper jams).
In such cases, take the appropriate action as described in the Printer Status tab.
In Windows Me, Windows 98, click the Guide tab and follow the instructions on screen.

Notes ➤ For details on the BJ Status Monitor, select the Help menu and click on the 
topic of interest.

➤ In Windows XP/Windows 2000, the Guide tab does not appear on the 
screen. Follow the instructions displayed on the Printer Status tab to 
correct an error.

When paper has run out:
BJ Status Monitor Functions 39
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Cancelling a Print Job

You can cancel a print job that is currently performed by:
• Pressing the RESUME/CANCEL button, or 
• Operating the BJ Status Monitor.

■ Cancelling a print job with the RESUME/CANCEL button on the printer

Press the RESUME/CANCEL button to terminate the print job.

RESUME/CANCEL button
Cancelling a Print Job 40
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■ Cancelling a print job from the BJ Status Monitor

1 Click the Canon BJ Status Monitor (Windows Me/Windows 98) or Canon 
S200 - USB001 (Windows XP/Windows 2000) icon on the Task Bar.

2 Click Cancel Printing.
Cancelling a Print Job 41



Printer Driver Functions (Windows)
Uninstalling Printer Drivers

Use the Uninstaller to delete any unwanted printer drivers. This allows you to delete all the 
files associated with the printer driver at the same time.

1 Click the Start button and select Programs, Canon S200, Uninstall.

In Windows XP, click the Start button and select All Programs.

2 Click Yes when the confirmation message appears.

3 When all the files have been deleted, click OK.

The deletion of the printer driver is complete.

If a message prompts you to restart your computer, click OK to restart your computer.

Note ➤ In Windows Me or Windows 98, you can also start the Uninstaller by 
double-clicking on Uninstall in the Canon S200 folder on the desktop.
Uninstalling Printer Drivers 42
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Printer Driver Functions (Macintosh)

• Description of Print Settings

• BJ Print Monitor

• Cancelling a Print Job

• Using the Printer with a Network

• Uninstalling Printer Drivers
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Description of Print Settings

• Page Setup Dialog Box

• Printer Utility 
Dialog Box

• Print Dialog Box

• Detailed Setting Dialog 
Box

• Options Dialog Box

• Register Settings 
Dialog Box
Description of Print Settings 44



Printer Driver Functions (Macintosh)
Page Setup Dialog Box

The Page Setup dialog box contains settings for the printed page, such as the size of the 
print media, and resizing the printed image. To open the Page Setup dialog box, select 
Page Setup from the application's File menu. 

(1) Paper Size 
Select the size of the paper for the print job. To enter the size manually, select 
Custom 1 - Custom 3 and click Custom. 

(2) Banner Printing 
Select this check box when printing on banner paper.

(8)

(1)
(2)

(5)
(3)

(6)
(4)

(7)
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(3) Scale 
Specify the scaling percentage to resize the document for printing.

(4) Orientation 
Select landscape or portrait printing. 

(5) Custom 
To specify a custom paper size, click this button to open the Custom dialog box after 
selecting Custom 1 to Custom 3 in the Paper Size pop-up menu. The Custom dialog 
box allows you to specify the length and width of the paper.

(6) Utilities 
Click to open the Printer Utility dialog box for maintenance operations, such as 
printhead cleaning, nozzle check pattern printing, and changing the print mode. 

(7) Save Settings 
Saves the settings specified in the Page Setup dialog box.

(8) Preview Area
This image allows you to confirm how the document will print with the selected paper 
settings.
Description of Print Settings 46



Printer Driver Functions (Macintosh)
Printer Utility Dialog Box

The Printer Utility dialog box is displayed when you click the Utilities button in the Page 
Setup dialog box.

(1) Select the function you wish to perform.

(2) Display area showing the various maintenance functions, including cleaning and test 
pattern printing. Click the icon to start this function. For further details, refer to 
“Routine Maintenance”. 

(1)

(2)
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Printer Driver Functions (Macintosh)
➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning

➡ Printhead Deep Cleaning

➡ Enabling Low Ink Warning

➡ Printhead Alignment

➡ Setting Ink Drying Wait Time
Description of Print Settings 48
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Print Dialog Box

The Print dialog box specifies the media type and print settings to be used for your print 
job. To open the Print dialog box, select Print from the application's File menu. 

(1) Media Type 
Ensure this setting matches the type of paper media loaded in the printer. 

(2) Grayscale Printing 
Select to print a grayscale version of a color document.

(3) Print Mode 
Select the icon that most closely resembles your document and required print results.

(1)

(2)

(3)
(4)

(5)

(6)
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(4) Details... 
Allows you to manually set the print quality and color settings in the Detailed Setting 
Dialog Box.

(5) Options... 
Specify the output destination, print order and page layout for the document you are 
printing. 

(6) Apply... 
Allows you to register print settings or to implement a previously registered print 
setting. 
Description of Print Settings 50
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Detailed Setting Dialog Box

To open the Detailed Setting dialog box, select Manual  in the Print dialog box and 
then click Details....

■ Quality panel

(1) Panel display icons
Click these icons to switch between panels in the Detailed Setting dialog box.

(1)
(2)

(3)
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(2) Print Quality 
Move the slide bar to adjust the balance between print quality and speed. Moving the  
bar to the right enhances print quality, and moving it to the left increases printing 
speed.

(3) Halftoning 
Select either Dither or Diffusion ink dot configurations. 
Description of Print Settings 52
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■ Special Effects Panel

To display the Special Effects panel, click the Special effects display icon. 

(1) Simulate illustration 
This function manipulates a color image with certain effects. Select the check box and 
adjust the brightness of the image with the Contrast slide bar.

(5)

(1)

(2)

(3)
(4)
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(2) Monochrome effects 
Prints a color image in a single color. Select the check box and choose a color or use 
a custom color using Select Color.

(3) Vivid Photo
Prints a photo or image data in vivid color.
Note that this effect is disabled when you select ColorSync as Color Correction on 
the Color Panel.

(4) Photo Optimizer PRO 
Optimizes the color of images taken from a digital camera or scanner. It is especially 
useful for images affected by color imbalance and over- or under-exposure.
When printing several images on one page, optimization is usually applied to each 
image according to its requirements. However, if the image data has been 
manipulated using cut and paste, rotation or other operations, group optimization of all 
images on the page is recommended. In such cases, select the  Apply Throughout 
Page check box. 

(5) Preview Area
Shows how your page will look when printed.
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■ Color Panel

To display the Color panel, click the Color display icon. 

(1) Color Correction
Select a color correction method: BJ Standard, ColorSync or None. BJ Standard is 
usually the optimum color correction method for printing with a BJ printer. When 
ColorSync is selected, you should also specify the Print Type and Printer Profile 
settings.

(1)
(2)
(3)
(4)

(5)

(6)
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(2) Print Type 
For printing that emphasizes intermediate colors, select Photo. For printing that 
emphasizes the brightness of primary colors, select Graphics. For documents that 
contain large amounts of a basic color, select Spot Color.

(3) Printer Profile 
Select optimized color characteristics (a profile) for the media type and other factors. 

(4) Gamma Correction 
This function adjusts the color contrast (not including pure black and white). To adjust 
the contrast, select the check box and move the slide bar. Moving the bar to the right 
darkens the entire image while increasing contrast in the lighter areas and decreasing 
contrast in the darker areas.

(5) Color Balance
Move the bar for each color to adjust the balance of color intensity. Moving the bar to 
the right intensifies the color.

(6) Intensity 
Move the slide bar to adjust the print density. Moving the bar to the right increases the 
density. 
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Options Dialog Box

To open the Options dialog box, click the Options... button in the Print dialog box.

(1) Page Layout 
Use this function to print more than one page on a single sheet of paper. Typically, this 
setting is set to display 1 Page/Sheet Printing. If another option is selected, Page 
Order and Border can be specified.

(1)

(4)

(3)

(5)
(6)

(7)

(2)
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2 Page/Sheet Printing / 4 Page/Sheet Printing
Pages are reduced and printed so that two or four pages fit on each printed page. 
You can also select page order and whether to place a border around each page.

Poster (Divided into 4) / (Divided into 9) / (Divided into 16) 
These enlarge and split the print image across several sheets of paper. The printer 
sheets can then be assembled to make a large poster. You can also select Cut/
Paste lines and Cut/Paste string. To print only the certain pages, click the specific 
pages on the Preview Area.

(2) Two-sided Printing
Prints data on both sides of a sheet of paper.  Note that when the printer finishes 
printing data on the front side of paper, it pauses and displays the message.  Follow 
this message to reverse the printed paper, and load it in the printer.  
When you select this function, use Stapling Side to specify which side is to be 
stapled, longer side or shorter side of a sheet of paper. Select the margin for stapling 
with Margin for stapling.  If you are stapling on the longer side of the paper, be sure 
to place a sheet of paper lengthwise, and check Long-side stapling.  If you are 
stapling on the shorter side of the paper, place paper widthwise, and check Short-
side stapling.

(3) Fit-to-page Printing 
Executes the scaled printing automatically. When selected, you can specify the 
Printer Paper Size.
This option fits the document paper size set in the application to the paper size loaded 
in the printer.

(4) Destination 
Select the print output destination. Printer is the usual selection. 
To check the layout or other image elements before printing, select Preview. To save 
the document as a PICT file, select PICT File.
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(5) Print in reverse order 
Prints the document starting with the last page. 

(6) Print collated pages 
Prints multiple copies of the document one copy at a time. 

(7) Preview Area
Shows how your page will look when printed.
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Register Settings Dialog Box

To open the Register Settings dialog box, click the Apply... button in the Print dialog box.

(1) Settings 
Displays a list of the registered print settings.

(2) Import 
Imports a set of print settings. To use the settings, select the desired settings in the 
Settings list and click the Import button.

(3) Apply 
Saves the settings currently specified in the Print dialog box. After clicking the button, 
enter the name under which the settings are to be saved. 

(4) Remove 
Deletes unwanted print settings. To delete unwanted settings, select the settings in 
Settings and click the Remove button. 

(5) Defaults 
Restores the print settings to the defaults. A check mark appears next to the selected 
print settings.

(1)

(2)

(3)

(4)

(5)
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BJ Print Monitor

The BJ Print Monitor allows you to check the progress of print jobs. 
You can launch the BJ Print Monitor if background printing is enabled in the Chooser utility.

■ Opening the BJ Print Monitor

1 Select Chooser from the Apple Menu.

2 Set Backgrounding to On.

3 After starting a print job, select BJ Print Monitor in the Application menu. 

The BJ Print Monitor launches.
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■ BJ Print Monitor Functions

The BJ Print Monitor allows you to change the print order of documents queued for printing.
To change the print order, place the mouse pointer over the name of the document, hold the 
mouse button down while dragging the document name to the new position, then release. 
When the print order change includes the current job, it stops and the new job immediately 
starts instead.

 ... Click to pause printing of the specified document.

 ... Click to resume printing.

 ... Click to cancel printing of the specified document.

Shows the progress of the current print job. 

Displays information about the documents queued for printing. 
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Cancelling a Print Job

■ Cancelling a print job with the RESUME/CANCEL button on the printer

Press the RESUME/CANCEL button to terminate the print job.

RESUME/CANCEL button
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■ Cancelling a print job from the BJ status monitor

When the BJ Print Monitor is running, you can use it to cancel or suspend the current 
print job.

1 Select BJ Print Monitor in the Application menu. 

2 Click the name of the print job you wish to cancel, then click .

The document selected in the Print Monitor is deleted from the print list and 
the print job is cancelled. 

Note ➤ To suspend printing, click the name of the document being printed then 
click . To resume printing, click . 
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Using the Printer with a Network

The printer can be used with an Ethernet network environment. Follow the steps below to 
connect the printer to the network. 

■ Before Setting up the Printer

Install the printer driver on each network computer that will use the printer.
For information on installation, refer to the Quick Start Guide.

■ Printer Setup

To use the printer on a network, first set up the print server, then set up each client 
machine.

• Print server setup procedure

1 Select Chooser in the Apple menu.

2 Select Active in AppleTalk.

3 Select the S200 icon, then select the printer name in Connected to:.
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4 Click Share.

5 Confirm that S200 server is selected in Enter new print server name. 
Then click Send. 

6 Confirm that the new print server name has been added to Current print 
servers. Then click Close.

7 Click the close box to close the Chooser.

• Client setup procedure

1 Select Chooser in the Apple menu.

2 Select Active in AppleTalk.

3 Select the S200 (Server) icon, and then select the printer server in 
Connected to.

4 Click the close box to close the Chooser.
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■ Checking Print Status

• Checking print status from the print server
To check the status of a print job from the print server, start the BJ Print Monitor. 
Select BJ Print Monitor in the Application menu.
To close the BJ Print Monitor, select Close Status Window in the File menu.

• Checking print status from a client
To check the status of a print job from a client, start the BJ Status Monitor. Click the 
BJ Status Monitor icon in the BJ Extras folder.
To close the BJ Status Monitor, select Quit in the File menu.

• The BJ Print Monitor and BJ Status Monitor
The BJ Print Monitor and the BJ Status Monitor both display a list of documents 
queued for printing. This information includes the document name, number of pages, 
number of copies and the time when the print job was accepted. The total number of 
queued documents is also displayed. 
The BJ Print Monitor allows you to change the print order of the queued documents.

➡ BJ Print Monitor Functions

➡ BJ Status Monitor Functions
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■ BJ Status Monitor Functions

....Click to pause printing of the specified document. 

....Click to resume printing. 

....Click to cancel printing of the specified document.

Note ➤ • You can determine the owner of a computer by selecting the File Sharing 
control panel and checking the Owner Name item.

• If you are using two or more printer servers, you can switch between the 
BJ Status Monitor displays. Select Print Server in the File menu, then 
select the desired print server and click OK.
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Uninstalling Printer Drivers

When a printer driver is no longer needed, use the Installer to delete it along with all 
associated program files.

Before proceeding, ensure you save any unsaved files in any currently running applications. 

1 Load the Setup Software & User's Guide CD-ROM.

2 Double-click the Printer Driver folder.

3 Double-click the Installer icon.

4 When the Software License Agreement is displayed, click Accept if you 
agree.

5 Select Uninstall from the pop-up menu, and then click Uninstall.

Note ➤ If a warning message appears, indicating that other applications are 
running:
• Click Cancel and save the document(s) if unsaved documents are open.
• Click Continue to continue the uninstall operation.

6 After the uninstall is complete, a message appears, prompting you to 
restart your computer. Click Restart. 
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Routine Maintenance

• When to Replace Ink Tank and Maintain Printhead

• Replacing an Ink Tank

• Printing the Nozzle Check Pattern

• Printhead Cleaning

• Printhead Deep Cleaning

• Printhead Alignment

• Enabling Low Ink Warning

• Setting Ink Dry-Up Time

• Transporting the Printer
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When to Replace Ink Tank and Maintain Printhead

When printing becomes faint or colors are incorrect, follow the procedures below and 
replace an ink tank if necessary.

➡ Printing the Nozzle Check Pattern

If the print quality is poor

➡ Printhead Cleaning

If the problem remains

➡ Printhead Deep Cleaning

Still the problem remains

➡ Replacing an Ink Tank

If printhead cleaning and ink tank replacement do not resolve the problem, the printhead 
may be worn out. Contact the Customer Care Center.

Note ➤ You will be alerted if you enable a low ink warning.

➡ Enabling Low Ink Warning
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Replacing an Ink Tank

When replacing an ink tank, ensure that you've purchased the correct tanks. The printer will 
not print properly if an incorrect ink tank is used, or installed in the incorrect position.

• Black: BCI-24 Black
• Color: BCI-24 Color

Note ➤ Damage caused by using a refilled cartridge is not covered by the Canon 
warranty. Canon recommends using only original Canon ink tanks to 
ensure the best quality.

1 Ensure that the printer is plugged in, and then open the front cover.

The cartridge holder moves to the center.
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2 Remove the empty ink tank.

Pull the tab on the ink tank toward you to release.

Then lift it from its slot.

Do not touch the lock lever; remove only the ink tank.

Important ➤ • Handle ink tanks carefully to avoid staining clothing or the surrounding area.
• Discard empty ink tanks according to the local laws and regulations 

regarding disposal of consumables.

color black
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3 Unpack a new ink tank and remove the orange protective cap.

Important ➤ • Do not re-attach the protective cap once you have removed it. 
• Once you have removed the protective cap, do not touch the open ink port. 

protective cap
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4 Insert the ink tank into a slot.
Replacing an Ink Tank 75



Routine Maintenance
5 Press on the tab until the ink tank snaps firmly into place.

6 Close the front cover.

The cartridge holder moves to the right. The ink tank installation process is 
now complete.

Note ➤ • To maintain optimal print quality, use an ink tank within six months of first use.
• Once an ink tank has been used, do not remove it from the printer and 

leave it out in the open. This will cause the ink tank to dry out and the 
printer may not function properly if it is reinstalled.
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Printing the Nozzle Check Pattern

Print the nozzle check pattern to determine whether the ink ejects from the printhead 
nozzles, and to verify printhead alignment. Use this function when printed results are 
blurred or the color is incorrect.

Nozzle check pattern printing can be executed from the Windows and Macintosh printer 
drivers, or from the printer itself.

■ Printing the Nozzle Check Pattern from the Printer Drivers

Windows

1 With the printer on, load a sheet of Letter or A4 paper in the printer.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Nozzle Check icon.

4 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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Macintosh

1 With the printer on, load a sheet of Letter or A4 paper in the printer.

2 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utilities dialog box.

4 Select Test Print from the pull-down menu, and then click the Nozzle 
Check icon.

5 When the confirmation message is displayed, click OK.

➡ Examining the Nozzle Check Pattern
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■ Printing the Nozzle Check Pattern through the Printer

1 With the printer on, load a sheet of Letter or A4 paper in the printer.

2 Press the RESUME/CANCEL button twice quickly.

➡ Examining the Nozzle Check Pattern
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■ Examining the Nozzle Check Pattern

The nozzle check pattern should appear as follows when ink is discharged properly. 
Examine the nozzle check pattern output by the printer.

Unevenness in these patterns 
indicates the printhead requires 
alignment.

Lines missing here 
indicate the printhead 
requires cleaning.
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Printhead Cleaning

Clean the printhead if you suspect that the nozzles might be clogged.

Note ➤ Cleaning the printhead consumes ink, so perform cleaning only when 
necessary.

Windows

1 Ensure that the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab, and then click the Cleaning icon.

4 When a confirmation message is displayed, click OK.
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Macintosh

1 Ensure the printer is on.

2 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utility dialog box.

4 Select Cleaning from the pull-down menu, and then click the Cleaning 
icon.

When a confirmation message is displayed, click OK.
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Printhead Deep Cleaning

If print quality does not improve by standard printhead cleaning, try deep cleaning, which is 
a more powerful process. Perform printhead deep cleaning from the printer driver.

Note ➤ Printhead deep cleaning consumes more ink than standard printhead 
cleaning, so perform this procedure only when necessary.

Windows

1 Ensure the printer is on.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Deep Cleaning icon.

4 When the confirmation message is displayed, click OK.
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Macintosh

1 Ensure the printer is on.

2 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utility dialog box.

4 Select Cleaning from the pull-down menu, and then click the Deep 
Cleaning icon.

5 Click OK.

After printhead deep cleaning finishes, print the nozzle check pattern to verify that the 
printhead is clean. If not, perform printhead deep cleaning once more. If the printhead is still 
not clean after the second deep cleaning, the printhead may be worn out, even if ink 
remains in the ink tanks. In this event, contact the Customer Care Center.

➡ Printing the Nozzle Check Pattern
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Printhead Alignment

Aligning the printhead positions allows you to print without shifts in the color registration.

■ Aligning the Printhead

Windows

1 With the printer on, load a sheet of Letter or A4 paper in the printer.

2 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

3 Click the Maintenance tab and then click the Print Head Alignment icon.

4 When the confirmation message is displayed, click OK.

➡ Examining the Print Head Alignment Pattern
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Macintosh

1 With the printer on, load a sheet of Letter or A4 paper in the printer.

2 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

3 Click the Utilities button to open the Printer Utilities dialog box.

4 Select Test Print from the pull-down menu, and the click the Print Head 
Alignment icon.

5 When the confirmation message is displayed, click OK.

➡ Examining the Print Head Alignment Pattern
Printhead Alignment 86



Routine Maintenance
■ Examining the Print Head Alignment Pattern

Windows

1 Look at the print-out. From the patterns in Column A, select the most even, 
least irregular pattern and enter the number.
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2 In the same way, one by one, select the most even patterns printed with the 
least irregularities from each of Columns B to E, enter their numbers, and 
click OK.

If it is difficult to pick the best pattern on Column E, pick the setting that 
produces the least noticeable vertical white stripes.

3 Click OK.

This completes the printer setup. The printer is now ready to use.

Less noticeable
white stripes
Less noticeable
white stripes

More noticeable
white stripes
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Macintosh

1 Look at the print-out. From the patterns in Column A, select the most even, 
least irregular pattern and enter the number.
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2 In the same way, one by one, select the most even patterns printed with the 
least irregularities from each of Columns B to E, enter their numbers and 
click Send.

If it is difficult to pick the best pattern on Column E, pick the setting that 
produces the least noticeable vertical white stripes.

3 Click Close.

4 Click OK.

This completes the printer setup. The printer is now ready to use.

Less noticeable
white stripes
Less noticeable
white stripes

More noticeable
white stripes
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Enabling Low Ink Warning

The low ink warning can be enabled/disabled from the printer driver. This notifies you of low 
ink levels during printing. It is disabled by default. 

■ How Low Ink Warning Works

Enable a low ink warning when installing a new ink tank.

Reset the ink counter of the ink tank installed.

When ink becomes low...

The low ink warning alerts.

When you install a new ink tank...

When you reset the ink counter, it will assume the ink tank is full regardless how much ink is 
actually remains.  The reset is the only way to match the counter value with an actual ink 
volume.  Therefore only enable the low ink warning and reset the ink counter when installing 
a new ink tank.

➡ How to Display Low Ink Warning Correctly
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■ Low Ink Warning Display

The '!' shows a low ink level in the ink tank.

BJ Status Monitor (Windows)

BJ Status dialog box 
(Macintosh)

The color ink 
becomes low.

The color ink 
becomes low.
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Note ➤ When the background printing is enabled, the low ink warning is displayed 
on the BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ How to Display Low Ink Warning Correctly

• Reset the ink counter every time you install a new ink tank
The ink counter cannot work correctly unless you synchronize it with the actual ink 
level.  The ink counter can only be adjusted when it is reset at the time a new ink tank 
is installed.

• Do not reset the ink counter of an ink tank in use.
Synchronization of the counter and the actual ink level will not work properly.

Note ➤ • Although ink counters for black and color ink tanks work independently 
from each other, both start simultaneously when you enable the low ink 
warning.  So if you did not reset the counter when you installed the 
current ink tanks, the low ink warning may not function correctly until the 
next time you replace the ink tanks.  Also, ensure you treat both counters 
separately.

• Refer to 'Low Ink Warning Displays Ink Tank with '?''.
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■ Setting Low Ink Warning

Note ➤ Reset the ink counter each time you install a new ink tank and you have 
enabled the low ink warning.  Otherwise the ink levels will not be displayed 
accurately.

• Enabling Low Ink Warning

Windows

1 Ensure the printer is on and open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click Low Ink Warning Setting icon.

3 Select Display low ink warning and click Send.

Macintosh

1 Ensure the printer is on and open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities icon to open the Printer Utility dialog box.
Enabling Low Ink Warning 94



Routine Maintenance
3 Select Low Ink Warning from the pull-down menu and click the 
Remaining ink level setting icon.

4 Select Display low ink warning and click Send.

• Resetting Ink Counter

Note ➤ Do not reset an ink counter of an ink tank already in use.

Windows

1 Ensure the printer is on and open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click the Ink Counter Reset icon.

3 Select the ink tank you have just installed and click Execute.

Macintosh

1 Ensure the printer is on and open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities button to open the Printer Utility dialog box.
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3 Select Remaining ink level setting from the pull-down menu and click Ink 
Counter Reset.

4 Select the ink tank you have just installed and click Execute.
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Setting Ink Drying Wait Time

When you set the ink drying time level, you can specify which printing characteristic is 
preferred: printing speed or quality.

■ How to Set the Ink Drying Wait Time

Windows

1 Ensure the printer is on and open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab, click the Custom Settings button.

3 Click and drag the Ink Drying Wait Time slider to set the ink drying time 
level.

4 Click the Send button to send this setting to the printer.

The message box appears on the screen. Click OK.
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Macintosh

1 Ensure the printer is on and open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities button to open the Printer Utilities dialog box.

3 Select Custom Setting from the pull-down menu, and then click the Ink 
Dry setting icon.

4 Click and drag and the scroll bar to specify the desired time level: 1, 2 or 3.

The leftmost level (1) indicates that the printer waits for the shortest time 
until ink dries up, while the rightmost level (3) indicates that it waits for the 
longest time.
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Transporting the Printer

Pack the printer carefully in its original packing materials.

If you do not have the original packing materials, pack the printer carefully and thoroughly in 
protective material inside of a sturdy box.

1 Unplug the printer.
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2 Remove the paper rest and the paper output tray.

3 Disconnect the printer cable from the computer and from the printer, and 
then disconnect the power cord from the printer.
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4 Secure the printer with adhesive tape as shown, and then pack it in a 
plastic bag.
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5 Attach protective material to both sides of the printer when packing the 
printer.

Clearly label the box as “Fragile”, if using a transport company.
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Printing Media

• Compatible Media Types

• Envelopes

• High Resolution Paper

• Glossy Photo Paper

• High Gloss Photo Film

• Glossy Photo Cards

• Photo Paper Pro

• Photo Paper Pro 4x6

• Transparencies

• T-Shirt Transfers

• Banner Paper
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Compatible Media Types

You can use the following types of paper and other media.

■ Size

• Standard paper: From legal size (8.5 x 14.0 in / 215.9 x 355.6 mm) to 
A5 size (5.83 x 8.27 in / 148.0 x 210.0 mm) 

• Non-standard paper: From 3.94 x 3.94 in to 9.5 x 23.0 in
                                  (From 100.0 x 100.0 mm to 241.3 x 584.2 mm)

• Others: Envelopes (US Com. #10 or European DL)

Important ➤ Do not use the following types of paper. Using such paper will not only 
produce unsatisfactory results, but can also cause the printer to jam or 
malfunction.
• Folded, curled or wrinkled paper
• Wet paper
• Paper that is too thin (less than 17 lb / 64 g/m2)
• Paper that is too thick (more than 28 lb / 105 g/m2)
• Picture postcards
• Postcards with an affixed photo or sticker
• Envelopes with a double flap
• Sealed envelopes
• Envelopes with an embossed or treated surface 
• Paper with holes (such as loose-leaf paper)
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■ Weight

17 to 28 lb (64 to 105 g/m2)
Do not use paper heavier than this, as it could jam in the printer.

■ Types

The following types of media can be used.
For more information about the media and the printing methods, refer to the specific 
sections.

➡ Envelopes

➡ High Resolution Paper

➡ Glossy Photo Paper

➡ High Gloss Photo Film

➡ Glossy Photo Cards

➡ Photo Paper Pro

➡ Photo Paper Pro 4x6

➡ Transparencies

➡ T-Shirt Transfers

➡ Banner Paper
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Envelopes

Use either US Com. #10 or European DL size envelopes.

■ Preparation for Printing

1 Press down on all four corners and edges of the envelopes to flatten them 
as shown below.

2 If the envelopes are curled, hold the opposite corners and gently bend 
them in the opposite direction.

Ensure that the flap of the envelope is perfectly straight.
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3 If the leading edge of an envelope is puffed up or curled, use a pen to press 
the envelope flat and sharpen the crease.

The envelopes may jam in the printer if they are not completely flat and the 
edges are not aligned.

Ensure that no curl or puff exceeds  0.1 in (3 mm).

■ Unsuitable Envelopes

• Envelopes with an embossed or treated surface 
• Envelopes with a double flap or pressure seals

Press the envelope completely flat, 
working from the middle to the edge.

* The above illustrations show a side view of the leading edge of the 
envelope.
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■ Loading

• Place envelopes lengthwise with the flap to the left and the address side facing 
upwards.

• Set the paper thickness lever to the right.
• Up to 5 envelopes can be loaded at once.

Paper thickness lever Paper guide
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■ Printer Driver Settings

• Media Type: Envelope
• Page Size: Select either #10 Env. or DL Env. according to the envelope size you 

are using
• Orientation: Portrait

■ Handling of Printed Output

Remove each envelope as it is printed.

■ Printable Area

➡ Printing Area
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Printing Media
High Resolution Paper

This type of paper provides better color reproduction than plain paper. It is suitable for 
printing business documents that feature graphics, and for photographs.

■ Loading

• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.
• Do not load paper higher than the limit mark. A maximum of 40 sheets can be loaded.

Paper thickness lever

Print side (Whiter side)
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Printing Media
■ Printer Driver Settings

• Media Type: High Resolution Paper
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

Do not stack more than 20 sheets in the paper output tray. If the output paper is curled, it 
may prevent the next sheet being ejected. In this case, or if the ink takes a long time to 
dry, remove each sheet as soon as it is printed.

■ Printable Area

➡ Printing Area
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Printing Media
Glossy Photo Paper

This media is still thicker than High Resolution Paper with a glossy printing surface to 
produce printouts close to photograph quality.

■ Loading

• Load only one sheet at a time.
• Load the paper with the whiter side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print side (Whiter side)
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Printing Media
Note ➤ When printing on Glossy Photo Paper, do not use any loading support 
sheet.

■ Printer Driver Settings

• Media Type: Glossy Photo Paper
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink dries (approx. two minutes).

■ Printable Area

➡ Printing Area
Glossy Photo Paper 113



Printing Media
High Gloss Photo Film

This film has an extremely glossy surface, ideal for printing photographs with outstanding 
results.

■ Loading

• Load only one sheet at a time.
• Load the film with the cut corner at the upper right.
• If the film is curled, flatten it by curling in the opposite direction.
• Set the paper thickness lever to the left.

Paper thickness lever Cut corner
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Printing Media
■ Printer Driver Settings

• Media Type: High Gloss Photo Film
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed.
• Do not touch the printed surface until the ink dries.

■ Printable Area

➡ Printing Area
High Gloss Photo Film 115



Printing Media
Glossy Photo Cards

Made of the same material as Glossy Photo Paper, this photo-size paper is intended for 
printing images that cover the entire surface of the card, without a white border. To take full 
advantage of Glossy Photo Cards, make the images slightly larger than the area indicated 
by the perforations.

■ Loading

• Load only one sheet at a time.
• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• Do not use the loading support sheet provided with the package.

Paper thickness lever

Print side (Glossy side)
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Printing Media
■ Printer Driver Settings

• Media Type: Glossy Photo Paper
• Page Size: Select Custom Size and enter 4.7 x 8.5 in (119.6 x 215.9 mm).

■ Applications Settings

Enter 4.31 x 6.31 in (109.6 x 160.4 mm) in Image Size.
For details on how to specify the image size, refer to the applications user manual.
You may not be able to specify the size of the image correctly in some applications.

■ Handling of Printed Output

• Remove each card as soon as it is printed.
• Do not touch the printed surface until the ink dries (approx. two minutes).

■ Printable Area

➡ Printing Area
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Printing Media
Photo Paper Pro

This is thick paper with a treated surface that enhances gloss and provides superior color 
reproduction. It is ideal for printing high quality photographs.

■ Loading

• Load only one sheet at a time.
• Load the paper with the glossier side facing up.
• Set the paper thickness lever to the left.

Paper thickness lever

Print side (Glossier side)
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Printing Media
■ Printer Driver Settings

• MediaType: Photo Paper Pro
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each sheet as soon as it is printed. 
• Do not touch the printed surface until the ink dries (approx. 30 minutes).

Colors in dark images may appear indistinct at first, but become clearer after about 30 minutes.
• Images may smudge if you place them in an album before the ink is completely dry. It is 

recommended that you allow the ink to dry for 24 hours.
• Do not attempt to dry the ink with a hair dryer or by exposing printed sheets to direct sunlight.

■ Storing Printed Output

• Do not store or display printouts in hot, damp or humid conditions.
Never expose them to heat or direct sunlight.

• Store printouts in photo albums, photo frames or presentation binders to protect them 
from direct exposure to air or sunlight.

• Do not mount printouts in an adhesive-type album, as you may not be able to remove them.
• Be aware that some types of clear plastic folders and albums may cause the edges of 

the paper to turn yellow.

■ Printable Area

➡ Printing Area
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Printing Media
Photo Paper Pro 4x6

Made of the same material as Photo Paper Pro, this photo-size paper is intended for 
printing images that cover the entire surface of the card, without a white border. To take full 
advantage of Photo Paper Pro 4x6, make the images slightly larger than the area indicated 
by the perforations. This paper is ideal for printing high quality photographs.

■ Loading

• Load the paper with the glossy side facing up.
• Set the paper thickness lever to the left.
• A maximum of 1 sheet can be loaded at once.

Print side (Glossy side)

Paper thickness lever
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Printing Media
■ Printer Driver Settings

• Media Type: Photo Paper Pro
• Page Size: Select Custom Size and enter 4.67 x 8.5 in (118.6 x 215.9 mm).

■ Applications Settings

Enter 4.31 x 6.31 in (109.6 x 160.4 mm) in Image Size.

For details on how to specify the image size, refer to the application’s user manual. You 
may not be able to specify the size of the image correctly in some applications.

■ Handling of Printed Output

Follow the instructions described in “Photo Paper Pro”.

■ Printable Area

➡ Printing Area
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Printing Media
Transparencies

This film is ideal for printing presentation material for use with overhead projectors.

■ Loading

• Place one sheet of plain Letter or A4 paper under the transparencies in the sheet feeder.
• Set the paper thickness lever to the left.
• A maximum of 20 sheets can be loaded at once.

Paper thickness lever
Plain paper

Transparencies
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Printing Media
• Although you can print on either side of the media, best results can be obtained by 
printing on the side toward which it curls when held by the edge.

■ Printer Driver Settings

• Media Type: Transparency
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each transparency as soon as it is printed.
• Do not touch the printed surface until the ink dries (approx. 15 minutes).

■ Printable Area

➡ Printing Area

Print side
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Printing Media
T-Shirt Transfers

This paper is used to produce iron-on transfers. The image is printed backward when 
Media Type is set to T-Shirt Transfer in the printer driver.

Note ➤ For the customers in the United States, refer to the instructions included in 
the package for details on using T-Shirt transfers.

■ Loading

• Load only one sheet at a time.
• If the T-shirt transfer is curled, flatten it by curling it in the opposite direction.
• Load the paper with the side that does not have green lines facing up.
• Set the paper thickness lever to the right.

Paper thickness lever
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Printing Media
■ Printer Driver Settings

• Media Type: T-Shirt Transfer
• Page Size: Ensure the setting matches the size set in the application.

■ Handling of Printed Output

• Remove each T-shirt transfer as soon as it is printed.
• The T-shirt transfer should be used as soon as possible. Refer to the supplied 

instructions for details on how to use apply the transfer.

■ Printable Area

➡ Printing Area
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Printing Media
Banner Paper

This is long paper that consists of consecutive sheets of Letter or A4 size paper, ideal for 
printing long posters or banners (up to six sheets long).

■ Preparation for Pinting

• When tearing the banner paper, tear off one more sheet than you actually need to print.
• The maximum length for one print job is six sheets, so if you will be printing on six 

sheets, tear off a seven-sheet length.

■ Loading

1 Set the Paper Thickness Lever to the right.

2 Load the banner paper with the printing side facing up. Gently fold the 
perforation between the first and second sheets.

Leave the rest of the paper folded up.
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Printing Media
3 Place the printer where the printed banner output can hang over the edge 
of the table.

Ensure the ink does not stain the table or floor.
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Printing Media
■ Printer Driver Settings

• Media Type: Plain Paper
• Page Size: When using letter size banner paper: Letter

When using A4 banner paper: A4

• Printing Type: Banner Printing
On a Macintosh, before creating the document, select Banner 
Printing in the Page Setup dialog box.

• Copies: Must be set to “1” to print correctly. 

■ Printable Area

➡ Printing Area
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Troubleshooting
Troubleshooting

• Cannot Install the Printer Driver

• Print Quality is Poor or Contains Errors

• Printer Does Not Start or Stops During Print Jobs

• Paper Does Not Feed Properly or Paper Jams

• An Error Message is Displayed on the Screen

• Low Ink Warning Displays Ink Tank with '?'

• Problems Unique to Windows 

• Problems Unique to the Macintosh 

Windows

Macintosh
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Troubleshooting
Cannot Install the Printer Driver

■ Follow the installation procedure correctly.

Install the printer driver carefully following the procedures described in the Quick Start 
Guide.

If the printer driver was not installed correctly, reinstall it. If you are using Windows, 
delete the printer driver before reinstalling it.

➡ Uninstalling Printer Drivers

Note ➤ If the Installer was forcibly terminated due to an error in Windows, Windows 
may be unstable and this will prevent the printer driver from being installed. 
Restart the computer before reinstalling the printer driver.

■ Close any other applications before installation.

Sometimes the printer driver cannot be installed because another application is running.
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Troubleshooting
■ If the Installer for the printer driver does not start up automatically when you insert 
the Setup Software & User’s Guide CD-ROM, open the My Computer window, and 
then double-click the CD-ROM icon. 

Windows

Note ➤ If you are typing in the file name, you must specify the CD-ROM drive letter 
and the installation program (“MSetup.exe”). The CD-ROM drive letter is 
computer dependent.

■ Confirm that there are no problems with the Setup Software & User’s Guide 
CD-ROM.

In Windows, use Explorer to ensure that the CD-ROM can be read. On a Macintosh, 
check that the CD-ROM icon is visible. If there is a problem with the CD-ROM, contact 
the Customer Care Center.
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Troubleshooting
Print Quality is Poor or Contains Errors

• Cannot Print to End of Job

• Colors are Unclear

• Meaningless Characters or Symbols are Printed

• Printing is Blurred/Colors are Wrong

• Straight Lines are Misaligned

• Printed Paper Curls or Ink Blots

• Back of Paper is Smudged

• Printed Surface is Scratched

• White Streaks

• Colors are Uneven or Streaked
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Troubleshooting
Cannot Print to End of Job

■ Confirm the Page Size setting matches the size of the paper loaded in the printer.

First, check the Page Size setting in the application.

Then check the Page Size setting in the Printer Properties dialog box for Windows or the 
Page Setup dialog box for Macintosh.

■ Check the amount of the free space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.
Print Quality is Poor or Contains Errors 133



Troubleshooting
Colors are Unclear

■ Confirm the Media Type setting in the printer driver matches the type of paper 
loaded in the printer.

If you are printing a photograph or an illustration from a Windows environment, also 
increase Print Quality on the Main tab.
If you are working in a Macintosh environment, select the Photo or Graphic icon for 
the Print Mode in the Print dialog box.

■ Confirm the specified ink tank is installed.

When an ink tank runs out of ink, replace it with a new one.

Note ➤ Printed colors may not match screen colors perfectly due to basic 
differences in the methods used to produce colors. Color control settings 
and environmental differences can also affect how colors appear on the 
screen.
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Troubleshooting
Meaningless Characters or Symbols are Printed

■ If the problem only occurs when printing a specific document, try editing the 
document and then printing it.

If this does not resolve the problem, there may be a problem with your application 
program. 
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Troubleshooting
Printing is Blurred/Colors are Wrong

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the printhead.

➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning

If the problem is not resolved after cleaning the printhead several times, replace either of 
the ink tanks. If print quality still remains poor, the printhead may be worn out. Contact 
the Customer Care Center.

Note ➤ Always ensure you dispose of the protective cap from a printhead.

■ Ensure you are printing on the correct side of the media.

You can only print on one side of certain media. 
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Troubleshooting
Straight Lines are Misaligned

■ Align the printhead.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Print Head Alignment.

Follow the instructions on the screen.
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Troubleshooting
Macintosh

1 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities button.

3 Select Test Print from the pull-down menu, and then click Print Head 
Alignment.

Follow the instructions on the screen.

Note ➤ Straight lines can become misaligned if the paper thickness lever has been 
moved. Aligning the printhead may also resolve this problem.
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Troubleshooting
■ In the printer driver settings, select a higher print quality setting.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

Usually, the Print dialog box can be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Quality icon and then drag the Print Quality slide bar to the Fine end.
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Troubleshooting
Printed Paper Curls or Ink Blots

■ Use high resolution paper or photo paper to print images that require a lot of ink 
(i.e., pictures with intense colors or photographs).

■ Reduce the Intensity setting in the printer driver and try printing again.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Color Adjustment, and then click Set.

3 Drag the Intensity slide bar to adjust the intensity.
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Troubleshooting
Macintosh

1 Open the Print dialog box.

Usually, the Print dialog box can be opened by selecting Print in the File 
menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Color icon and then drag the Intensity slide bar to set the 
intensity.
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Troubleshooting
Back of Paper is Smudged

■ If the next page prints before the ink is dry, click and drag the Ink Dry-Up Time 
slider to the rightmost position.

You can either remove each printed sheet from the output tray as soon as it is printed, 
or click and drag the Ink Dry-Up Time slider to the rightmost position to cause the  
printer to pause after each sheet has printed.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Maintenance tab.

3 Click Custom Settings to open the Custom Setting dialog box.

4 Click and drag the Ink Dry-Up Time slider to the rightmost position, and 
then click Send.
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Troubleshooting
Macintosh

1 Open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities button.

3 Select Custom Settings form the pull-down menu.

4 Select Pause between pages, and then click Send.
Print Quality is Poor or Contains Errors 143



Troubleshooting
Printed Surface is Scratched

■ Ensure you are using suitable paper.

• The paper weight must be less than 28 lb (105 g/m2).

If you use paper heavier than 28 lb (105 g/m2), the printhead may scratch the printed surface.
Clean the printhead first and print with the correct paper.

• The paper must not be curled.

This problem can be resolved by simply turning the paper over.

■ When printing on thick paper, set the paper thickness lever to the right.

This widens a gap between the printhead and the paper. Try this if the paper is scratched 
even when printing on plain paper. When the message displays, indicating that the 
position of the lever may be incorrect, continue printing.

■ Reduce the Intensity setting in the printer driver and try printing again.

When printing an image with high intensity, especially on plain paper, the paper may 
absorb too much ink and become wavy. This may cause the printed surface to become 
scratched.
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Troubleshooting
Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Manual for Color Adjustment, and then click Set.

3 Drag the Intensity slide bar to adjust the intensity.

Macintosh

1 Open the Print dialog box.

Usually, the Print dialog box can be opened by selecting Print in the File menu.

2 For Print Mode, select Manual, and then click Details.

3 Click the Color icon and drag the Intensity slide bar to set the intensity.

■ Ensure you are printing within the recommended printing area.

➡  Printing Area
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Troubleshooting
White Streaks

■ Print the nozzle check pattern to check the ink output.

If a specific color does not print in the nozzle check pattern, clean the printhead.

➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning
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Troubleshooting
Colors are Uneven or Streaked

■ Increase the print quality setting in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, click High for the Print Quality setting.

Macintosh

1 Open the Print dialog box.

Usually, the Print dialog box can be opened by selecting Print in the File menu.

2 For Print Mode, select Manual and then click Details.

3 Click the Quality icon and then drag the Print Quality slide bar to the Fine end.
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Troubleshooting
■ Set the halftoning method to Diffusion in the printer driver settings.

Windows

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Main tab, select Custom for the Print Quality setting, and click Set.

3 Click Diffusion for the Halftoning setting.

Macintosh

1 Open the Print dialog box.

Usully, the Print dialog box can be opened by selecting Print in the File menu.

2 For Print Mode, select Manual, and then click Details.

3 Click the Quality icon and then click Diffusion for the Halftoning setting.
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Troubleshooting
Printer Does Not Start or Stops During Print Jobs

• Printing Does Not Start

• Printing Stops Before It is Completed

• Printer Moves But Does Not Print

• Cartridge Holder Does Not Move
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Troubleshooting
Printing Does Not Start

■ Ensure the printer is plugged in.

Check to see if the printer is plugged into the power supply securely.

Note ➤ When printing a large amount of data such as a photo or graphics, it takes 
longer than usual to begin printing. Simply wait until the processing is 
completed.

■ Ensure the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other device, remove and reconnect the 
printer directly to the computer. Try printing again.
If printing is now successful, there may be a problem with the device.
Also there could be a problem with the cable(s). Replace the cable(s) and 
try printing again.
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Troubleshooting
■ Ensure the correct printer driver is selected.

In Windows, ensure that Canon S200 is selected in the Print dialog box.
In Macintosh, ensure that S200 is selected in the Chooser.

Note ➤ In Windows, you can set the Canon S200 as the default printer.

■ Ensure the printer port is set correctly. 

Set “USBPRNnn” or “USBnnn” (“n” represents a number) as the printer port.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 Click the Details tab (or Ports tab) and set the printer port.

Windows
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Troubleshooting
Printing Stops Before It is Completed

■ When the printer is processing a large amount of data.

When the printer is processing a large amount of data, such as a photo or graphics, it 
takes a long time for the computer to process the data, during which the printer may 
appear not to be functioning.

In addition, when continuously printing material that uses a large amount of black ink on 
plain paper, the printer will sometimes pause. In either case, simply wait until the 
processing is completed.

■ Halt the print job and unplug the printer for at least 15 minutes to cool the 
printhead.

The printhead can overheat when continuously printing for long time. To protect the 
printhead, the printer will sometimes pause automatically at a line break before resuming.
In this event, interrupt the print job at a convenient time and unplug the printer for at least 
15 minutes.

Furthermore, when continuously printing graphics or photos with intense colors, printing 
may stop to protect the printhead. In this case, printing will not resume. Unplug the 
printer and wait for at least 15 minutes.

Caution ➤ Inside the printer, the area around the printhead can become extremely 
hot. Do not touch the printhead or nearby components.
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Troubleshooting
Printer Moves But Does Not Print

■ Print the nozzle check pattern to ensure that ink is output correctly.

If the nozzle check pattern does not print correctly, clean the printhead.

➡ Printing the Nozzle Check Pattern

➡ Printhead Cleaning

If the problem is not resolved by cleaning the printhead several times, replace either of 
the ink tanks. If print quality still remains poor, the printhead may be worn out. Contact 
the Customer Care Center.
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Troubleshooting
Cartridge Holder Does Not Move

■ Ensure the printer is turned on.

The cartridge holder will not move unless the power is on. Check to see if the printer is 
plugged into the power supply securely. If not, close the front cover, and then plug the 
printer to the power supply.

■ If the front cover has been left open for a while, close and reopen it.

If the front cover is left open for more than 10 minutes, the printhead holder moves to the 
right to prevent the printhead from drying out. Close and reopen the front cover to return 
the holder.
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Troubleshooting
Paper Does Not Feed Properly or Paper Jams

• Paper Does Not Feed Properly

• Paper Jams
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Troubleshooting
Paper Does Not Feed Properly

■ Confirm the paper conditions.

• The paper is not too thick (less than 28 lb / 105g/m2).

• The number of sheets loaded does not exceed the recommended level.

• The paper is not creased, curled or wrinkled.

➡ Compatible Media Types

■ Ensure that the left edge of the paper just touches the paper guide.

■ When printing envelopes, see “Envelopes” in “Printing Media,” and prepare the 
envelopes before printing.

Once you have prepared the envelopes, load them in the printer in landscape orientation. 
If the envelopes are placed in portrait orientation, they may not feed properly.

■ When using transparencies, load one sheet of plain paper in the printer first, and 
then place the transparencies on top of it.

The last transparency may not feed properly unless there is a sheet of plain paper 
beneath it.
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Troubleshooting
Paper Jams

Remove the paper according to the following procedure.

1 Slowly pull the paper out, either from the sheet feeder or from the paper 
output slot, whichever is easier.

If the paper tears and a piece remains inside the printer, open the front 
cover and remove it. 

If you cannot pull the paper out, unplug the printer and plug it back on. The 
paper will be ejected automatically.

2 After removing all paper, close the front cover.

Note ➤ When reloading the paper into the printer, refer to “Paper Does Not Feed 
Properly” to confirm that you are using the correct paper and are loading it 
into the printer correctly.
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Troubleshooting
An Error Message is Displayed on the Screen

• Error Writing to USBxxx 

• Application Error or General Protection Fault 

• Other Error Messages 

• Other Error Messages 

Windows

Windows

Windows

Macintosh
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Troubleshooting
Error Writing to USBxxx 

■ Ensure the printer is plugged in.

The cartridge holder will not move unless the printer is plugged in. Check to see if the 
power cord is plugged into the power supply securely. If not, close the front cover, and 
then plug the printer to the power supply.

■ Ensure the printer is securely connected to the computer.

Note ➤ If you are using a switch box or other devices, remove and reconnect the 
printer directly to the computer and try printing again.
If printing is now successful, there may be a problem with the device.
Also there could be a problem with the cable(s). Replace the cable(s) and 
try printing again.

■ If spooling is enabled, disable it to send the print data directly to the printer and try 
printing again.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Details tab, click Spool Settings and then select Print directly to 
the printer.

Windows
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Troubleshooting
In Windows XP/Windows 2000, click the Advanced tab and then click Print 
directly to the printer.

■ Verify the USB port status.

1 Right-click My Computer and select Properties.
In Windows XP, click the Start button, then right-click My Computer and 
select Properties.

2 On the Device Manager tab, double-click Universal serial bus controller, 
and then double-click Canon S200.
In Windows XP/Windows 2000, click Device Manager... on the Hardware 
tab, double-click Universal serial Bus controller, and then double-click 
USB Printing Support.

3 On the General tab, check if there is any indication of a problem with the 
device.
In Windows XP, open the USB Printing Support Properties dialog box to 
see the General tab.
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Troubleshooting
■ Ensure that the printer port setting corresponds to the printer interface 
connection.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Details tab (or Ports tab), select USBPRNnn (Canon S200) or 
USBnnn (Canon S200) (“n” represents a number) in the Print to the 
following port.

■ There may be a problem in the printer driver. Uninstall the printer driver and 
reinstall it.

➡ Uninstalling Printer Drivers
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Troubleshooting
Application Error or General Protection Fault

■ Ensure the application you are using is intended for use on your operating 
system.

For example, if you attempt to print with a Windows 3.1 application under Windows 98, 
the application may not function correctly and an error may occur.
Use an application intended for use on your operating system.

■ If other applications are running, close them to increase available memory and try 
printing again.

■ Ensure that enough memory is allocated to the application.

Refer to the memory requirements of your application.

Windows
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Troubleshooting
■ Check the amount of free space on the hard disk.

You may need to increase the amount of free space by deleting any unnecessary files.

■ If the problem only occurs when printing a specific document, try editing the 
document and then printing it.

If this resolves the problem, there may have been a problem in the original document. If 
the same problem occurs with the edited document, contact the manufacturer of your 
application.

■ There may be a problem in the printer driver.  Uninstall the printer driver and 
reinstall it.

➡ Uninstalling Printer Drivers
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Troubleshooting
Other Error Messages 

■ If the BJ Status Monitor is displayed, follow the instructions on screen.

If an error occurs during printing, the BJ Status Monitor displays the error on the Printer 
Status tab. Follow the instructions on screen.

In Windows Me or Windows 98, click the Guide tab for action to be taken in response to 
the error.

Refer to ‘Low Ink Warning Displays Ink Tank with '?'’.

Windows
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Troubleshooting
■ If one of the following messages is displayed outside of the BJ Status Monitor:

Could not spool successfully due to insufficient disk space
Increase the amount of free space on the disk by deleting any unnecessary files.

Could not spool successfully due to insufficient memory
Increase available memory by closing any other applications currently running.

Printer driver could not be found
Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers

Background printing failed (Windows Me/Windows 98 only)
Restart Windows and try printing again.

Could not print Application name – File name
Try printing again once the current job is finished.
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Troubleshooting
Other Error Messages 

■ If a message with the format “Error No.: Xn” (where “X” represents a letter and “n” 
represents a number) is displayed:

Error No.: X202
Not enough memory for printing. Increase available memory by closing any other 
applications currently running.

Error No.: X203
There is a problem with the printer driver. Uninstall the printer driver and reinstall it.

➡ Uninstalling Printer Drivers
Error No.: X300
Ensure the power is on, and that the printer and the computer are securely connected. 
If the problem remains, verify the Chooser setting.

1 In the Apple menu, select Chooser.

2 Click the S200 icon and ensure S200 is selected as the connected 
destination.

If it is not selected, select it.

If the problem remains, delete all unnecessary documents from the Extensions and 
Control Panels folder.

Macintosh
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Troubleshooting
Low Ink Warning Displays Ink Tank with '?'

The ink level of an ink tank displayed with a '?' is not synchronized with its ink counter.

BJ Status Monitor (Windows)

BJ Status dialog box (Macintosh)

The color ink level 
may not be  
displayed 
correctly.

The color ink level 
may not be  
displayed 
correctly.
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Troubleshooting
Macintosh

Note ➤ When the background printing is enabled, the low ink warning displays on 
the BJ Print Monitor (Macintosh).

➡ BJ Print Monitor

■ Reset the ink counter from the printer driver when you replace the ink tank.

➡ Resetting Ink Counter

■ Turn the low ink warning off until you replace the ink tank to stop the warning 
message.

Windows

1 Ensure the printer is on and open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Maintenance tab, click the Low Ink Warning Setting icon.

3 Clear a check box of Display low ink warning off and click Send.
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Troubleshooting
Macintosh

1 Ensure the printer is on and open the Page Setup dialog box.

Usually, the Page Setup dialog box can be opened by selecting Page 
Setup... in the File menu.

2 Click the Utilities icon to open the Printer Utilities dialog box.

3 Select Remaining ink level setting from the pull-down menu and click the 
Low Ink Warning Setting icon.

4 Clear the Display low ink warning check box and click Send.

Note ➤ Also refer to 'Enabling Low Ink Warning' to display the ink level correctly.
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Troubleshooting
Problems Unique to Windows

• The BJ Status Monitor is Not Displayed

• Cannot Print in Background (Windows Me/Windows 98 only)

Windows
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Troubleshooting
The BJ Status Monitor is Not Displayed

■ Ensure “Enable bi-directional support for this printer” is selected.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Details tab, click Spool Settings and select Enable bidirectional 
support for this printer.

In Windows XP/Windows 2000, select Enable bidirectional support on 
the Ports tab.

Note ➤ Windows XP displays the BJ Status Monitor where you see the message 
asking you to set “Enable bi-directional support” to ON.
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Troubleshooting
Cannot Print in Background (Windows Me/Windows 98 only)

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space. You may need to delete 
unnecessary files, or disable background printing.

■ Ensure that background printing is enabled.

1 Open the Printer Properties dialog box.

➡ Opening the Printer Properties Dialog Box

2 On the Page Setup tab, click Printer control... and select Background 
Printing.

Note ➤ Windows XP/Windows 2000 does not support background printing.
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Troubleshooting
Problems Unique to the Macintosh

• Jagged Text or Graphics, or Banded Gradations

• Cannot Print in Background

Macintosh
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Troubleshooting
Jagged Text or Graphics, or Banded Gradations

■ Ensure your application supports Quick Draw.

If you are using a PostScript-compatible application, printed text and lines may appear 
jagged and gradations may appear banded. The S200 is not a PostScript printer, but is a 
Quick Draw printer. Use an application compatible with Quick Draw for printing.
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Troubleshooting
Cannot Print in Background

■ Ensure background printing is enabled.

1 In the Apple menu, select Chooser.

2 Click Backgrounding on.

■ Check the amount of free space on the hard disk.

Background printing requires a certain amount of disk space.
You may need to remove unnecessary files, or disable background printing.
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Appendices
Appendices

• Deleting an Unknown Device Windows
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Appendices
Deleting an Unknown Device

If the problem remains, follow the steps below to delete the unknown device.

1 Click the Start button, select Settings and click Control Panel. Double-
click System.In Windows XP, click My Computer with the right button to 
display the system properties.

2 Click the Device Manager tab.

In Windows XP/Windows 2000, click the Hardware tab, then click Device 
Manager....

3 Select the name of the printer or ‘Unknown device’ and click Remove.

In Windows XP/Windows 2000, click the unknown device, then click 
Uninstall in the Action menu.

Caution ➤ Be careful not to remove any other device. Windows may not function 
properly if another device is incorrectly deleted.

Windows
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Appendices
• If the unknown device is under Universal serial bus controller

• If the unknown device is under Other devices
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Appendices
4 When the confirmation message appears, click OK.

5 Click Close to close the System Properties window.

In Windows XP/Windows 2000, click  and then click OK in the System 
Properties window.

6 Click  at the top right of the Control Panel window to close it.

7 Unplug the printer.

8 Remove the Setup Software & User’s Guide CD-ROM, if it is in the drive.

9 Restart Windows.

10 Install the printer driver again following the instructions in the Quick Start 
Guide.
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Specifications
Specifications

Printing method:
Bubble Jet on-demand

Printing resolution:
2880 (horizontal) × 720 (vertical) dpi. max.*
* Ink droplets can be placed with a pitch of 1/2880 inch at minimum.

Print speed (printing with Canon standard pattern):
Black printing Draft: 5 ppm

Standard: 3.8 ppm
Color printing Draft: 3 ppm

Standard: 1.6 ppm

Print direction:
Bi-directional

Print width:
8.0 in (203.2 mm) max.

Resident print control mode:
Canon extended mode
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Specifications
Receive buffer:
64 KB

Interface:
USB-compatible 

Interface connector:
USB standard Series B receptacle (USB interface)

Recommended printer cable:
Material: AWG28 (data wiring pair) or AWG20 to 28 (distribution pair)
Type: Twisted-pair shielded cable
Length: Up to 16.4 ft (5.0 m)
Connectors: USB standard Series B pluggable

Acoustic noise level:
Approx. 43 dB (A) in the best print quality mode

Operating environment:
Temperature: 41 to 95˚F (5 to 35˚C)
Humidity: 10 to 90% RH (no condensation)

Storage environment:
Temperature: 32 to 95˚F (0 to 40˚C)
Humidity: 5 to 90% RH (no condensation)
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Specifications
Power supply:
USA/Canada AC 120-127 V, 60 Hz
Europe AC 230 V±10%, 50 Hz
Australia AC 240 V, 50 Hz

Power consumption:
Standby: Approx. 2 W
Printing: Approx. 18 W

Even though you do not use the printer, it consumes a little power unless 
you unplug it. To prevent such power consumption, disconnect the power 
cord from the power supply.

Dimensions (without a paper rest and paper output tray):
15.35 (W) × 7.44 (D) × 6.38 in (H)
390 (W) × 189 (D) × 162 mm (H)

Weight:
Approx. 5.28 lb. (2.4 kg)
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Specifications
■ Feed method:

Continuous feed through auto sheet feeder
For Plain Paper, High Resolution Paper, Envelopes,
Glossy Photo Paper, High Gloss Photo Film,
Glossy Photo Cards, Photo Paper Pro,
Transparencies, T-Shirt Transfers, Banner Paper

■ Sheet feeder capacity:

Plain Paper (75 gsm) 50 sheets max.
High Resolution Paper 40 sheets max.
Envelopes 5 pieces max.
Glossy Photo Paper 1 sheet
High Gloss Photo Film 1 sheet
Glossy Photo Cards 1 sheet
Photo Paper Pro 1 sheet
Photo Paper Pro 4x6 1 sheet
Transparencies 20 sheets max.
T-Shirt Transfers 1 sheet
Banner Paper 6 sheets max.
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Specifications
■ Ordinary print media:

Regular size: Letter, Legal, A4, A5, B5, European DL, US Com.#10

Custom size: width: 3.94 to 9.5 in (100.0 to 241.3 mm)*
height: 3.94 to 23.0 in (100.0 to 584.2 mm)*
*except Banner Paper

Weight: 17 to 28 lb (64 to 105 g/m2)

Canon Special media:
High Resolution Paper
Glossy Photo Paper
High Gloss Photo Film
Glossy Photo Cards
Photo Paper Pro
Photo Paper Pro 4x6
Transparencies
T-Shirt Transfers
Banner Paper
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Specifications
■ Graphic image printing:

Data format: Canon extended mode: Raster image format

Resolution: Canon extended mode: 360, 720, 2880 dpi

■ Print Head:

Black: 64 nozzles (360 dpi)

Cyan, Magenta, Yellow: 24 nozzles per each color (360 dpi)

■ Ink Tanks:

Capacity:
Black (BCI-24 Black) approx. 340*1, approx. 520*2

Color (BCI-24 Color) approx. 130*2

*1 1500 characters per page, normal text, at standard and plain paper mode with 
Windows Me/Windows 98

*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and plain paper 
mode with Windows 98/Windows Me
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Specifications
■ Printer driver operating environment:

IBM PC/AT-compatible computer running on Windows XP, Windows Me, 
Windows 2000, Windows 98 or Macintosh computers with USB interface running 
on Mac OS 8.6  - Mac OS 9.X

■ Hard disk space:

Approx. 15 MB to install on Windows Me and Windows 98, 30 MB on Mac OS, or 
approx. 25 MB to install on Windows XP and Windows 2000 (including temporary 
files)

Note ➤ • BJ Status Monitor cannot be used when printer is used in network 
operating environment.

• Use the system under the following operating environment.

Windows Computer with Microsoft Windows Me or Windows 98, which is preinstalled 
by a computer manufacturer on purchase. (USB port operation also needs 
to be assured by the manufacturer.)

Macintosh Macintosh computers with USB and Mac OS 8.6  - Mac OS 9.X, which is 
preinstalled by a computer manufacturer on purchase.

Specifications subject to change without prior notice.
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Specifications
■ Printing Area

To ensure the best print quality, the printer allows a margin along each edge of  
media. 

Printing area (dark blue): Canon recommends that you print within this area.  
( )

Printable area (light blue): The area where it is possible to print.  However, printing 
in this area can adversely affect the print quality or the 
paper feed precision.  ( )

➡ A4, B5, A5

➡ Letter, Legal

➡ Glossy Photo Cards

➡ Photo Paper Pro 4x6

➡ Envelopes

➡ Banner Paper
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Specifications
A4, B5, A5

Size Printable Area (width x height)

A4 8.0 × 11.3 in / 203.2 × 287.0 mm

B5 6.9 × 9.8 in / 175.2 × 247.0 mm

A5 5.6 × 7.9 in / 141.2 × 200.0 mm

1.0 in / 25.4 mm 

0.93 in / 23.5 mm 

0.13 in / 3.4 mm  0.13 in / 3.4 mm

0.28 in / 7.0 mm 

0.12 in / 3.0 mm 

Recommended printing area

Printable area
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Specifications
Letter, Legal

Size Printable Area (width x height)

Letter 8.0 × 10.6 in / 203.2 × 269.4 mm

Legal 8.0 × 13.7 in / 203.2 × 345.6 mm

1.1 in / 28.0 mm

1.04 in / 26.5 mm 

 0.25 in / 6.4 mm 0.25 in / 6.3 mm 

 0.28 in / 7.0 mm

0.12 in / 3.0 mm

Recommended printing area

Printable area
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Specifications
Glossy Photo Cards

Size Printable Area (width x height)

Glossy Photo Card 4.3 × 6.3 in / 109.4 × 159.9 mm

0.2 in / 5.1 mm 0.16 in / 4.1 mm

1.02 in / 26.0 mm

1.1 in / 28.0 mm

Recommended printing area
(Printable area is the same.)
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Specifications
Photo Paper Pro 4x6

Note ➤ The printing area of Photo Paper Pro is identical to that of A4 size paper. 
For details, refer to ”A4, B5, A5”.

Size Printable Area (width x height)

Photo Paper Pro 4x6 4.3 × 6.3 in / 109.6 × 160.4 mm

0.16 in / 4.0 mm 0.16 in / 4.0 mm

1.1 in / 28.0 mm

1.1 in / 28.0 mm

Recommended printing area
(Printable area is the same.)
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Specifications
Envelopes

Size Printable Area (width x height)

European DL 8.0 × 3.9 in / 203.2 × 100.0 mm

US Com. #10 8.0 × 3.7 in / 203.2 × 94.8 mm

0.25 in / 6.4 mm US Com. #10: 1.25 in / 31.7 mm
European DL: 0.41 in / 10.4 mm

0.28 in / 7.0 mm 

0.12 in / 3.0 mm 

Printable area
192



Specifications
Banner Paper

Size Printable Area (width x height)

Banner Paper Letter: 8.0 × 65.6 in / 203.2 × 1666.4 mm

A4: 8.0 × 69.8 in / 203.2 × 1772.0 mm

0.13 in / 3.4 mm

0.13 in / 3.4 mm

0.12 in / 3.0 mm
1.0 in / 25.4 mm 0.28 in / 7.0 mm

Max. 6 sheets
Min. 2 sheets

Recommended printing area

Printable area
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Index
Index

A
Application Error 162

B
Background printing (Macintosh) 61
Background printing (Windows) 172
Banner Paper 126
BCI-24 Black 72
BCI-24 Color 72
BJ Print Monitor (Macintosh) 61
BJ Status Dialog (Macintosh) 92, 167
BJ Status Monitor (Macintosh) 68
BJ Status Monitor (Windows) 37, 92, 164, 167, 171
Booklet Printing 27

C
Cancelling a Print Job (Macintosh) 63
Cancelling a Print Job (Windows) 40
Chooser (Macintosh) 61
Cleaning 35, 47, 81
Client (Macintosh) 66
Compatible Media Types 104
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Index
D
Deep Cleaning 35, 83
Deleting an Unknown Device (USB interface) 177
Duplex Printing 27

E
Enabling Low Ink Warning 91
Envelopes 106
Error Message 158, 164, 166

F
Front cover 16, 154

G
Gamma Correction (Macintosh) 56
General Protection Fault 162
Glossy Photo Cards 116
Glossy Photo Paper 112

H
High Gloss Photo Film 114
High Resolution Paper 110

I
Ink Counter Reset 36, 95
Ink Dry-Up Time 97
Ink Tank 71, 72
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L
Low Ink Warning 36, 91
Low Ink Warning Displays Ink Tank with '?' 167

M
Media Type (Macintosh) 49
Media Type (Windows) 24

N
Network (Macintosh) 65
Nozzle Check Pattern 80

O
Opening the Printer Properties Dialog Box (Windows) 21

P
[Page Setup] Dialog Box (Macintosh) 45
Page Size (Windows) 26
Paper Jams 157
Paper Output Tray 16
Paper Rest 16
Paper Size (Macintosh) 45
Paper Thickness Lever 18
Photo Optimizer PRO (Macintosh) 54
Photo Optimizer PRO (Windows) 32
Photo Paper Pro 118
Photo Paper Pro 4x6 120
PICT File (Macintosh) 58
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	On the Maintenance tab, click Low Ink Warning Setting icon.
	Select Display low ink warning and click Send.
	Ensure the printer is on and open the Page Setup dialog box.
	Click the Utilities icon to open the Printer Utility dialog box.
	Select Low Ink Warning from the pull-down menu and click the Remaining ink level setting icon.
	Select Display low ink warning and click Send.


	Resetting Ink Counter
	Ensure the printer is on and open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Maintenance tab, click the Ink Counter Reset icon.
	Select the ink tank you have just installed and click Execute.
	Ensure the printer is on and open the Page Setup dialog box.
	Click the Utilities button to open the Printer Utility dialog box.
	Select Remaining ink level setting from the pull-down menu and click Ink Counter Reset.
	Select the ink tank you have just installed and click Execute.



	Setting Ink Drying Wait Time
	How to Set the Ink Drying Wait Time
	Ensure the printer is on and open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	Click the Maintenance tab, click the Custom Settings button.
	Click and drag the Ink Drying Wait Time slider to set the ink drying time level.
	Click the Send button to send this setting to the printer.
	Ensure the printer is on and open the Page Setup dialog box.
	Click the Utilities button to open the Printer Utilities dialog box.
	Select Custom Setting from the pull-down menu, and then click the Ink Dry setting icon.
	Click and drag and the scroll bar to specify the desired time level: 1, 2 or 3.



	Transporting the Printer
	Unplug the printer.
	Remove the paper rest and the paper output tray.
	Disconnect the printer cable from the computer and from the printer, and then disconnect the powe...
	Secure the printer with adhesive tape as shown, and then pack it in a plastic bag.
	Attach protective material to both sides of the printer when packing the printer.
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	Envelopes
	High Resolution Paper
	Glossy Photo Paper
	High Gloss Photo Film
	Glossy Photo Cards
	Photo Paper Pro
	Photo Paper Pro 4x6
	Transparencies
	T-Shirt Transfers
	Banner Paper
	Compatible Media Types
	Size
	Weight
	Types
	Envelopes
	High Resolution Paper
	Glossy Photo Paper
	High Gloss Photo Film
	Glossy Photo Cards
	Photo Paper Pro
	Photo Paper Pro 4x6
	Transparencies
	T-Shirt Transfers
	Banner Paper


	Envelopes
	Preparation for Printing
	Press down on all four corners and edges of the envelopes to flatten them as shown below.
	If the envelopes are curled, hold the opposite corners and gently bend them in the opposite direc...
	If the leading edge of an envelope is puffed up or curled, use a pen to press the envelope flat a...

	Unsuitable Envelopes
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	High Resolution Paper
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	Glossy Photo Paper
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	High Gloss Photo Film
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	Glossy Photo Cards
	Loading
	Printer Driver Settings
	Applications Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	Photo Paper Pro
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Storing Printed Output
	Printable Area
	Printing Area


	Photo Paper Pro 4x6
	Loading
	Printer Driver Settings
	Applications Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	Transparencies
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	T-Shirt Transfers
	Loading
	Printer Driver Settings
	Handling of Printed Output
	Printable Area
	Printing Area


	Banner Paper
	Preparation for Pinting
	Loading
	Set the Paper Thickness Lever to the right.
	Load the banner paper with the printing side facing up. Gently fold the perforation between the f...
	Place the printer where the printed banner output can hang over the edge of the table.

	Printer Driver Settings
	Printable Area
	Printing Area



	Troubleshooting
	Cannot Install the Printer Driver
	Print Quality is Poor or Contains Errors
	Printer Does Not Start or Stops During Print Jobs
	Paper Does Not Feed Properly or Paper Jams
	An Error Message is Displayed on the Screen
	Low Ink Warning Displays Ink Tank with '?'
	Problems Unique to Windows
	Problems Unique to the Macintosh
	Cannot Install the Printer Driver
	Uninstalling Printer Drivers

	Print Quality is Poor or Contains Errors
	Cannot Print to End of Job
	Colors are Unclear
	Meaningless Characters or Symbols are Printed
	Printing is Blurred/Colors are Wrong
	Straight Lines are Misaligned
	Printed Paper Curls or Ink Blots
	Back of Paper is Smudged
	Printed Surface is Scratched
	White Streaks
	Colors are Uneven or Streaked

	Cannot Print to End of Job
	Colors are Unclear
	Meaningless Characters or Symbols are Printed
	Printing is Blurred/Colors are Wrong
	Printing the Nozzle Check Pattern
	Printhead Cleaning

	Straight Lines are Misaligned
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	Click the Maintenance tab.
	Click Print Head Alignment.
	Open the Page Setup dialog box.
	Click the Utilities button.
	Select Test Print from the pull-down menu, and then click Print Head Alignment.
	Open the Printer Properties dialog box.

	Opening the Printer Properties Dialog Box
	On the Main tab, click High for the Print Quality setting.
	Open the Print dialog box.
	For Print Mode, select Manual and then click Details.
	Click the Quality icon and then drag the Print Quality slide bar to the Fine end.


	Printed Paper Curls or Ink Blots
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Main tab, select Manual for Color Adjustment, and then click Set.
	Drag the Intensity slide bar to adjust the intensity.
	Open the Print dialog box.
	For Print Mode, select Manual and then click Details.
	Click the Color icon and then drag the Intensity slide bar to set the intensity.


	Back of Paper is Smudged
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	Click the Maintenance tab.
	Click Custom Settings to open the Custom Setting dialog box.
	Click and drag the Ink Dry-Up Time slider to the rightmost position, and then click Send.
	Open the Page Setup dialog box.
	Click the Utilities button.
	Select Custom Settings form the pull-down menu.
	Select Pause between pages, and then click Send.


	Printed Surface is Scratched
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Main tab, select Manual for Color Adjustment, and then click Set.
	Drag the Intensity slide bar to adjust the intensity.
	Open the Print dialog box.
	For Print Mode, select Manual, and then click Details.
	Click the Color icon and drag the Intensity slide bar to set the intensity.

	Printing Area

	White Streaks
	Printing the Nozzle Check Pattern
	Printhead Cleaning

	Colors are Uneven or Streaked
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Main tab, click High for the Print Quality setting.
	Open the Print dialog box.
	For Print Mode, select Manual and then click Details.
	Click the Quality icon and then drag the Print Quality slide bar to the Fine end.
	Open the Printer Properties dialog box.

	Opening the Printer Properties Dialog Box
	On the Main tab, select Custom for the Print Quality setting, and click Set.
	Click Diffusion for the Halftoning setting.
	Open the Print dialog box.
	For Print Mode, select Manual, and then click Details.
	Click the Quality icon and then click Diffusion for the Halftoning setting.


	Printer Does Not Start or Stops During Print Jobs
	Printing Does Not Start
	Printing Stops Before It is Completed
	Printer Moves But Does Not Print
	Cartridge Holder Does Not Move

	Printing Does Not Start
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	Click the Details tab (or Ports tab) and set the printer port.


	Printing Stops Before It is Completed
	Printer Moves But Does Not Print
	Printing the Nozzle Check Pattern
	Printhead Cleaning

	Cartridge Holder Does Not Move
	Paper Does Not Feed Properly or Paper Jams
	Paper Does Not Feed Properly
	Paper Jams

	Paper Does Not Feed Properly
	Compatible Media Types

	Paper Jams
	Slowly pull the paper out, either from the sheet feeder or from the paper output slot, whichever ...
	After removing all paper, close the front cover.

	An Error Message is Displayed on the Screen
	Error Writing to USBxxx
	Application Error or General Protection Fault
	Other Error Messages
	Other Error Messages

	Error Writing to USBxxx
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Details tab, click Spool Settings and then select Print directly to the printer. In Window...
	Right-click My Computer and select Properties. In Windows XP, click the Start button, then right-...
	On the Device Manager tab, double-click Universal serial bus controller, and then double-click Ca...
	On the General tab, check if there is any indication of a problem with the device. In Windows XP,...
	Open the Printer Properties dialog box.

	Opening the Printer Properties Dialog Box
	On the Details tab (or Ports tab), select USBPRNnn (Canon S200) or USBnnn (Canon S200) (“n” repre...

	Uninstalling Printer Drivers

	Application Error or General Protection Fault
	Uninstalling Printer Drivers

	Other Error Messages
	Uninstalling Printer Drivers

	Other Error Messages
	Uninstalling Printer Drivers
	In the Apple menu, select Chooser.
	Click the S200 icon and ensure S200 is selected as the connected destination.


	Low Ink Warning Displays Ink Tank with '?'
	BJ Print Monitor
	Resetting Ink Counter
	Ensure the printer is on and open the Printer Properties dialog box.

	Opening the Printer Properties Dialog Box
	On the Maintenance tab, click the Low Ink Warning Setting icon.
	Clear a check box of Display low ink warning off and click Send.
	Ensure the printer is on and open the Page Setup dialog box.
	Click the Utilities icon to open the Printer Utilities dialog box.
	Select Remaining ink level setting from the pull-down menu and click the Low Ink Warning Setting ...
	Clear the Display low ink warning check box and click Send.


	Problems Unique to Windows
	The BJ Status Monitor is Not Displayed
	Cannot Print in Background (Windows Me/Windows 98 only)

	The BJ Status Monitor is Not Displayed
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Details tab, click Spool Settings and select Enable bidirectional support for this printer.


	Cannot Print in Background (Windows Me/Windows 98 only)
	Open the Printer Properties dialog box.
	Opening the Printer Properties Dialog Box
	On the Page Setup tab, click Printer control... and select Background Printing.


	Problems Unique to the Macintosh
	Jagged Text or Graphics, or Banded Gradations
	Cannot Print in Background

	Jagged Text or Graphics, or Banded Gradations
	Cannot Print in Background
	In the Apple menu, select Chooser.
	Click Backgrounding on.


	Appendices
	Deleting an Unknown Device
	Deleting an Unknown Device
	Click the Start button, select Settings and click Control Panel. Double- click System.In Windows ...
	Click the Device Manager tab.
	Select the name of the printer or ‘Unknown device’ and click Remove.
	When the confirmation message appears, click OK.
	Click Close to close the System Properties window.
	Click at the top right of the Control Panel window to close it.
	Unplug the printer.
	Remove the Setup Software & User’s Guide CD-ROM, if it is in the drive.
	Restart Windows.
	Install the printer driver again following the instructions in the Quick Start Guide.


	Specifications
	Printing method:
	Printing resolution:
	Print speed (printing with Canon standard pattern):
	Print direction:
	Print width:
	Resident print control mode:
	Receive buffer:
	Interface:
	Interface connector:
	Recommended printer cable:
	Acoustic noise level:
	Operating environment:
	Storage environment:
	Power supply:
	Power consumption:
	Dimensions (without a paper rest and paper output tray):
	Weight:
	Feed method:
	Continuous feed through auto sheet feeder

	Sheet feeder capacity:
	Plain Paper (75 gsm) 50 sheets max.
	High Resolution Paper 40 sheets max.
	Envelopes 5 pieces max.
	Glossy Photo Paper 1 sheet
	High Gloss Photo Film 1 sheet
	Glossy Photo Cards 1 sheet
	Photo Paper Pro 1 sheet
	Photo Paper Pro 4x6 1 sheet
	Transparencies 20 sheets max.
	T-Shirt Transfers 1 sheet
	Banner Paper 6 sheets max.

	Ordinary print media:
	Regular size: Letter, Legal, A4, A5, B5, European DL, US Com.#10
	Custom size: width: 3.94 to 9.5 in (100.0 to 241.3 mm)* height: 3.94 to 23.0 in (100.0 to 584.2 m...
	Weight: 17 to 28 lb (64 to 105 g/m2)
	Canon Special media:

	Graphic image printing:
	Data format: Canon extended mode: Raster image format
	Resolution: Canon extended mode: 360, 720, 2880 dpi

	Print Head:
	Black: 64 nozzles (360 dpi)
	Cyan, Magenta, Yellow: 24 nozzles per each color (360 dpi)

	Ink Tanks:
	Capacity:
	*1 1500 characters per page, normal text, at standard and plain paper mode with Windows Me/Window...
	*2 Based on printing the ISO JIS-SCID No.5 pattern at standard and plain paper mode with Windows ...

	Printer driver operating environment:
	IBM PC/AT-compatible computer running on Windows XP, Windows Me, Windows 2000, Windows 98 or Maci...

	Hard disk space:
	Approx. 15 MB to install on Windows Me and Windows 98, 30 MB on Mac OS, or approx. 25 MB to insta...

	Printing Area
	To ensure the best print quality, the printer allows a margin along each edge of media.
	Printing area (dark blue): Canon recommends that you print within this area. ()
	Printable area (light blue): The area where it is possible to print. However, printing in this ar...
	A4, B5, A5
	Letter, Legal
	Glossy Photo Cards
	Photo Paper Pro 4x6
	Envelopes
	Banner Paper

	A4, B5, A5
	Letter, Legal
	Glossy Photo Cards
	Photo Paper Pro 4x6
	Envelopes
	Banner Paper
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